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RSC 12: MANUSCRIPT PUBLICATION: FROM CONCEPT NOTES TO SUBMISSION 
At IAMT, we focus a lot on publication (see RSC3 Why publish and why is this so hard in our field?!) to find 
out why) and, over the years, have developed a pretty structured process that enables everyone to write. 
Sometimes, I get asked how we manage to publish so many papers. It does not feel like many, it is extremely 
hard work, and it does not seem to get easier. Maybe this has to do with ever-increasing standards. Anyhow, 
in 2009, I was receiving a colleague and mentor in Edinburgh, and I was interrupting the revision of a 
manuscript to pick him up. I had a manuscript draft in front of me, was spending several days battling through 
it and knew that my comments and revisions would be hugely demotivating. The structure was not good, 
and neither were many other things, the reward for my huge effort would be a very irritated PhD student. 
My guest, Prof Meny Elimelech, listened to my frustration and then shared the paper of George Whitesides 
[1], with his comments. It was extremely surprising to me that I was not alone in these struggles! What a gift, 
and what an amazing idea to work with bullet points and start with an outline of the manuscript before 
heading to the lab. Over the years, I asked my team relentlessly to read this paper, we worked with the highly 
informative videos of Whitesides [2], and I got so much of these materials every time I engaged with them. I 
have developed a concept note (CON) template that is used at IAMT to plan research from before heading 
to the lab through to manuscript submission. The result is a pretty good process that helps focus and develop 
the story. This RSC is sharing what we have learnt, developed and polished over the course of >100 
manuscripts. It is a tool that many collaborators have asked if they could adopt it, yet others do not like the 
idea at all as they perceive it, at least initially, as restrictive. Often I hear later that it was actually really 
helpful, which reflects the experience of Whitesides. Here this method is shared, may it be useful to you in 
case you have been experiencing similar issues in lerning to do research or in guiding research (Attachment 
RSC12 Concept Note Template).  
The cover page is most important, and be mindful, usually there is no need to read the rest of the document 
if the first page is not clear. It is not just a form to be filled, it requires a lot of thought – and reading of 
literature. The purpose of each section is very deep, and it is well worth spending a considerable amount of 
time filling this first page, for if one knows what one wants to say, the writing is easy. If one does not, it is 
impossible and results in forever procrastination. The process is iterative to some extent, it is adaptable (after 
all, results do not always pan out as expected!), but it is not inviting a random style ‘let’s just see what 
happens in the lab and then ty and see what can be published’. Whiole this can frustrate those who just want 
to head to the lab and try, the more thought is invested upfront, the better the data and the story. It 
inevitable reduces wasteage of materials and time. And quality creates impact. So, what are the sections? 
 CONTRIBUTIONS: this is about who is involved in this work and, ultimately, who will co-author the 

manuscript. There are now two sections, one for confirmed authors and those who are not yet 
confirmed. The actual contribution is spelled out. RSC 9 Authorship: how to determine who is named as 
author or not? dealt with how IAMT considers authorship. This topic can be fairly diverse in how 
authorship decisions are made, and thus, it is important to be extremely transparent and discuss 
expectations early to avoid conflict or ill feelings later. Just adding everyone to the author list to avoid 
discomfort, or to ‘help’ juniors, is not the way.  

The planned publication section contains various administrative details such as file name version, date and 
when it was emailed (so I can find it in my overwhelming inbox). The planned final submission is a date that 
tends to be readjusted to the indefinite, losing the power of deadlines very quickly, learn to set a realistic 
date and then commit, bearing in mind that an average of 15 revisions will be required before submission!  
 REVISIONS: dates of previous versions show the length of the process. It is requested at IAMT that 

revisions be made within two weeks. An average of 15 revisions are required to get from 
conceptualization to manuscript submissions. This number is consistent with reports of Whitesides [2]. 
If every revision takes several months, one can see why some papers take years, which is not very 
competitive and delays a PhD. At IAMT, I request that I get manuscripts both on paper (this is my ‘to-do’ 
list that ensures I don’t oversee things) and email. I do not work on shared files accessible to all, as I find 
this both inefficient and not helpful when travelling, where lacking internet access (or even power on 
some airlines) demands working on paper. An interesting and surprising observation from the IAMT team 
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is that handwritten comments are perceived as better (despite my often illegible handwriting) as they 
force to look carefully as opposed to the temptation to ‘Accept all’ in electronic revisions.  

 TITLE: the title of the work ought to be both simple and specific, not claiming the entire filed and not 
being 5 lines long. Sart and then this will usually revise along with the manuscript until it is right and 
reflects the content as best can be. 

 RESEARCH AIM: the aim is how you would explain what you do all day at a dinner party (I like the thought 
of explaining it to my grandma, who was not a scientist). How will your research make the world a better 
place? Why would the taxpayer pay to have you do this work? This section usually is the most difficult to 
fill for some reason, possibly because of a disconnect between the research and personal motivation?  

 RESEARCH PROBLEM: which specific problem will your work solve? Just that no one did this before is not 
a problem. In fact, there may be very good reasons why no one did it before! Good research is 
incremental, and your increment needs to be justified here in terms of why it is important. This may be 
removing a process limitation or verifying a hypothesis that so far no one can answer. Inevitably, to define 
a good problem, a lot of reading and maybe talking to experts may be required - conferences are a good 
place for this. 

 RESEARCH QUESTIONS: to solve a research problem, three well-focused research questions are required. 
The research questions are shaped by the gaps in the literature related to the research problem, and 
they define what needs to be done to fill that gap. In experimental research, they will be addressed by 
various parameters that can be investigated, planning this carefully will reduce the number of parameters 
and inevitable effort. The magic number of three helps with focus.  

 NOVELTY: a common question in review is what is novel in this work, which is the primary criterion of 
being publishable. Just doing the same that was previously published by someone else in a different 
geographic location, a different water, or another pollutant is not enough. The novelty does not need to 
be a paradigm shift or a breakthrough, as many claim their work to be. Good research is inevitably 
incremental, but the increment must be real, and this can be difficult. What are you doing that no one 
did before? How does your work contribute new knowledge? 

 KEYWORDS: which keywords would someone who you would like to find and read your work search for? 
Use words that are not already in your title. 

 PLANNED JOURNAL(S): decide what journal your work fits in best. Yes, we all try for the highest impact 
(factor) possible, but firstly, the topic must match the journal, and secondly, the quality of the work must 
match that of the journal. Start by looking at the journals you cite, this usually gives an indication of 
where this community publishes. Usually, there are many options. 

 ACKNOWLEDGEMENTS: being able to say thank you is a virtue, and not every researcher understands its 
importance. No one can do research alone, at least not in the field of water process engineering, and it 
is an immense privilege to be able to carry out research. We receive a lot of assistance with funding 
materials, discussions, methods and reviewing, and this must be acknowledged. Fill this from the 
beginning such that the risk of forgetting someone is minimized.  

 RESTRICTIONS: sometimes, we have non-disclosure agreements (NDAs) in place, so we need to make 
sure that no confidential information is published or agreements to share publications with companies 
who give us materials. We do not normally engage with agreements that prevent publication as this 
conflicts with our role. And if you promised to let a material provider (usually membranes or adsorbents 
in our case) have the paper after publication, remember this and deliver! 

 POTENTIAL REVIEWERS: authors can suggest potential reviewers to the editors. It is IAMT practice that 
we suggest experts in the particular field of interest whom we know and respect. This is not friends whom 
we hope will waive us through, but people whose comments would really offer valuable and thorough 
critique and if we can convince them to be interested in our work and accept, it would be a huge 
compliment. Note that the list is a suggestion, not a guarantee, and editors will, of course, make their 
own choice. 

 PEER REVIEW AT IAMT: at IAMT, we have a peer review process where authors can select a team 
member who they think would offer a critical review. This is to teach the ability to review critically and 
point out our lack of clarity, etc. (rather than waive through) and an additional due diligence check. This 
is also an opportunity for a team member to see the work, that may be relevant to them, pre-publication. 

 BACKUP: all IAMT data is backed up for safe storage and data-keeping. 
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After this first page, the writing can begin, always in bullet points (1-3 lines, no more). I have regular 
discussions about someone needing more that three bullet points to describe their complex research. No, it 
is always about not wanting the hard work of prioritizing and focus. It is of course much harder to write short 
than long! The writing is an iterative process of figuring out what to do and how, structuring the literature, 
identifying parameters of interest, defining the number of experiments and, through repeated thorough 
revisions, developing this into a good story. The experimental results are added, which may redirect the story 
to some extent. This may involve the occasional ‘change of mind’ as the structure works better otherwise or 
something that was decided to omit earlier is again deemed necessary. This is the process, no one knows the 
right way beforehand in research. The work may grow from an initial 5 pages (that can vbe discussed in a 
meeting) to some 30 pages (that takes a day or more to revise) with an extensive supporting information file 
that includes a lot of additional information such as the calibration of analytical instruments, validation of 
data and the raw data. The language is bullet point style rather than full sentences such that the English 
language (grammar) is not the focus, while spelling is checked. When all this is complete, all experiments 
finished, the literature well structured, and the structure now is that of a well-rounded story, the full text can 
be written. After all this pre-labour this is usually a piece of cake! 
This CON process improved the situation drastically in terms of manuscripts being in good shape when in full 
text, I found that a lot of my effort was still on English language and formatting. At times, I was accused of 
never paying attention to science, but rather focusing on language and formatting. Yes, indeed, it is 
impossible for me to focus on science, when the language is illegible and the formatting is a mess. At some 
point, we created a template. This really transformed my life! It required some ruthlessness in that I bounced 
revisions if the format was not respected, a necessary step to signal that this was non-negotiable. That was 
a true breakthrough, for I was suddenly able to focus on the actual content! Many years ago, each journal 
had its own format that was to be followed. This has become a lot easier with ‘your paper your way’, and 
hence, it is possible for IAMT to have a generic template that is used. Some journals, e.g. the Nature family, 
have particular requirements for formatting, and this is something we look at when writing full text but only 
implement later for submission. The manuscript template (Attachment RSC12 Manuscript Template) 
teaches how to do headings, captions and cross-references, equation numbers, etc. and is hence quite a 
helpful instruction manual that prevents each team member from needing individual explanations on how 
to do these things. The template can be used from early on for any document, it is not a separate template 
once the full-text manuscript is written, but rather an instructions manual one can copy and paste into.  
For writing full text, there is a huge amount of writing literature available (for example, see [3-9]), and quite 
a lot focused on manuscript writing [1, 10, 11], in addition to a lot of YouTube videos and TED talks [2, 12]. 
This highlights that writing is not second nature to the majority of us! It is a good idea to read such resources 
from time to time for some inspiration, and there is plenty for everyone’s particular needs. Writing is a 
creative process [13, 14], includes varying degrees of self-expression and requires a degree of inspiration 
[15]. To do this well, one needs to be in a good mental place, ideally in a state of ‘flow’. I often have good 
ideas about what I want to say when reading or listening to talks, but even more so when hiking, biking, 
swimming or cooking. Being in flow requires good grounding and being undisturbed for long periods of time. 
As a result, I do a lot of my writing during the night and stop when things go well, rather than when I get 
stuck as this will lead to avoiding (or procrastinating) going back to it. Writing is about the communication of 
technical data and it requires identifying the purpose and target audience. Writer’s block is part of the 
process, occasionally, and moving through such blockage and the associated procrastination requires real 
effort and, on occasion, a psychologist! Everyone will need to find their own style, which will probably find a 
first expression in a master's or PhD thesis, while in a manuscript, this is a merged style of all authors that 
demands consistency, which is best achieved by one (the first) author taking the lead. At IAMT, we do not 
use active tense in manuscripts. In a thesis or a personal fellowship application, this can be considered, if so, 
it will require implementation with consistency. At the time of writing, IAMT did not use artificial intelligence 
(AI) in research writing because developing writing skills and the thought process that leads to a coherent 
structure and story is a key graduate skill to be developed. This includes developing a good command of the 
English language, and this is best obtained through regular revisions or thorough debugging efforts [16]. 
Busy professors are slow reviewers, not only because reviewing takes time, but also because there are so 
many tasks to be done that the wait can be quite long. When the supervisor then finally sits down to work 
on your concept note or manuscript and finds a mess, it may just happen that it gets bounced back for further 
revision, which starts the waiting cycle again. To avoid this, IAMT has a self/peer review checklist that enables 
authors and peers to check if everything obvious is in order (Attachment RSC12 Self-Peer Review Template). 
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This verifies if the templates are followed, if results are clear and comprehensible, if the literature is up to 
date, and perhaps most importantly, teaches the team critical revision and diligence, as well as time 
management. Scientific comments are not requested in this process, but welcome. It is obvious that this 
takes time, so doing this first of all oneself is important, while the time of others ought to be appreciated and 
not requested too often from the same person. 
Just before all is done, the manuscript is written in full text and ready to be submitted, there is another step 
that will enable the supervisor to submit or authorize submission after usually minor changes. To make sure 
that this does not have to do another round of revision for some formality, the submission checklist was 
created (Attachment RSC12 Submission Checklist). The most important aspects here are a compliance check 
with journal author guidelines and language proofing. Then, there is a requirement to attach all the required 
submission documents, from the cover letter through to the highlights and graphical abstract. At IAMT, 
language proofing is the responsibility of the first author and requires a native English speaker, either a friend 
or an editing service. The reason for this responsibility is that the academic supervisor is not in charge of 
teaching English, and a researcher has no interest in learning from mistakes if this is a service provided or 
paid for by someone else. Using all sorts of tools instead of a native speaker shows with often strange 
wordings, and this may be adequate enough, but more often than not reads odd and results in a pretty 
unauthentic style. 
What paper-writing bureaucracy?! It appears overwhelming, but once one has gone through the process a 
number of times, it becomes routine, and none of the items on the self/peer review or the submission 
checklist are overly surprising. When following the process diligently, everyone saves a lot of time, and the 
researchers can focus on the essence – the underlying science, the creative ideas and the problems that the 
research ought to help solve. Good and thoughtful planning based on current knowledge really assures that 
the research that is carried out is making a meaningful contribution. Further, doing this work prior to 
submission saves the precious time of editors and expert reviewers. 
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Concept Note (CON) 
Institute for Advanced Membrane Technology (IAMT) 

Prof. Dr. Andrea Iris Schäfer  

1. Contributions (authors with confirmed contribution) 

Name Affiliation Contribution Comments 
Researcher 1  -write actual contributions  
Researcher 2  -communicate with co-authors  
Andrea I. Schäfer IAMT   

Authors without confirmed contribution (potential authors who may contribute in the upcoming versions) 
Name Affiliation Expected contribution Comments 
Researcher 3    

2. Planned Research/Publication  
Current Draft Dates of previous versions Date of 

planned final 
submission to 

publisher 

File Name eg: Shepherd_CON1_MicropollutantNF_ v2   
Version vX Date Current draft date   

E-mailed on The date on which e-mailed to Prof. Schäfer 
(write this date on the print in the letterbox) 

   
  

Title  Title 
Research Aim A sentence about the purpose of the work as conceivable to a layperson (it should be so simple that 

your grandma could understand it !) 
Research Problem A sentence on the definition of the problem you are trying to solve with your research. Guessing the 

solution without defining the problem often looks really aimless and the solutions are not typically 
effective 

Research 
Questions 

 Three key research questions addressed in the work 
  
  

Novelty What is new in this work (be brealistic and elucidate the incremental contribution your work is making)? 
Keywords Add 6 keywords that do not repeat words from title, separate with ‘ ; ‘ 
Planned Journals Most suitable five journals  reason for choice Impact factor 

(IF (year)) 
Eg. Journal of Membrane Science   X.X (202X) 
Focus on why your particular work fits this 
selected journal, rather than evaluating the 
journal 

  

Check for fit by looking at your reference list, if 
you don’t cite the journal where you plan to 
sumit to there may not be a fit 

  

   
Acknowledgements [think early about who funded the work or contributed in other ways (e.g. analysis, scholarships, 

technical assistance, material donations, method development) so in the end no one is forgotten; 
writing the achknowledgments well is one of the most important aspects of your work] 

Restrictions [check prior to any publication if any Non-Disclosure Agreements are in place with project partners 
that may state publication conditions for certain materials; is there agreements in place that the data 
must be shared when published (this ius usually the case with membrane or sample suppliers); 
Discuss in advance if the ownership/contribution of materials, methods, expertise etc. from third 
parties is unclear] 

Potential Reviewers Most suitable five potential reviewers (Friends and 
fair critics!, researchers in similar field) 

Justification (relevant expertise to this CON) 

1. (Name, e-mail, institution)  
2.   
3.   
4.   
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5.   
Peer reviewed at 
IAMT by 

Specify your colleague who reviewd this version of 
your CON 

Add the date of review and comments if any 
(USE THE PEER/SELF REVIEW TEMPLATE 
PROVIDED) 

Backup data 
location in the 
intranet 

Assign a folder for each CON. This must contain ALL data associated with the CON such as raw data, 
raw images, calculations (excel sheets) and origin file as well as manuscript versions, schematics and 
graphs in editable formats. The data must be organized and described in such a way that it is 
comprehensible to a third person, especially, the supervisor, colleague who may want to use the data 
or an open repository.  

 

3. Abstract 

 write the abstract early and refer to manuscript template what to write 

 think about a good graphical abstract (GA) that summarizes your story early, you may need some 

skill and a few iteration to draw a good GA  

 refer to manuscript template for formatting requirements and more information on content 

4. Literature (word style ‘Heading-1) 

 [(word style ‘Bullet point’) Please add key concepts and state-of-the art from literature here, 

that emphasize the importance to do exactly what you are doing and that ultimately defines 

the gaps in literature that justifies your research questions (gaps are not gaps because you did 

not find the papers but because no one has done it -so search carefully);  

 in early CON stages there is no need for general water quality problems; focus on the novelty 

of your specific topic in this particular CON and very important key literature that is very 

close to your novelty; 

 note that this is concise and in bullet points, this is not the place for paper summaries or copy 

and pastes from your literature review document (if you happen to have one); 

 focus where possible on the highest quality papers – websites etc. are generally not acceptable 

unless very specific information (e.g. manufacturer datasheets)] 

4.1. (word style ‘Heading-2) 

 Sub-headings dedicated to specific topics 

 Focus on 3 main points 

5. Methodology (word style ‘Heading-1) 

 Write specific details about your project (not standard protocols). If any specific methodology 

needs to be developed for this work, that should be highlighted. 

 [(word style ‘Bullet point’) Briefly describe chemicals, membranes and pollutants, protocols, 

system setup, analytical methods, data analysis and calculations etc. that are planned to use in 

the work and that are specific to this particular CON 

 No details needed at this stage on methods are commonly used at IAMT, but rather specific 

changes in protocols and methods to be able to answer the specific research questions; 
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 Reference the first paper where the system/method you use has been developed and/or 

characterized. 

 Specify solution chemistry to ensure that you are following IAMT methods] 

5.1. Materials (word style ‘Heading-2) 

6. Results and Discussion (word style ‘Heading-1) 

 [(word style ‘Bullet point’) generally this starts in a CON by figuring out which parameters 

you wish to examine and why; this links to what do you need to do to answer your research 

questions; try and move away from ‘checking’ typical parameters without thinking about what 

exactly you need to learn (example: NOT: check the effect of pH on retention; BUT: is the 

negative charge of this ion enhancing the retention? To do so I need to change pH as the pKa 

is 9.5 and hence operating below this pKa gives me the neutral specie while above the negative) 

 what graphs would you like to have in your paper in the end to show that you can answer your 

research question or show that your hypothesis is correct;  

 how many experiments will this require (this helps your planning!), a good graph needs 7-8 

points and from the number of parameters to be investigated you can then work out the number 

of experiments, amount of materials and time required; 

 as the CON progresses to a paper outline you will start adding headings here and actual graphs 

with bullet point interpretation of the findings and the story will start taking shape 

 in each section (subheading) and in front of each graph/table put one question as to what you 

are needing to know and how/what you are planning will answer this (picking up from the 

above example: ok, there is more retention if the ion is negatively charged, but I cannot be 

sure if this is all the reason as the membrane may also change charge with pH and I also have 

competing ions/organics in solution. So now I need to examine the i) membrane charge OR 

ii) the retention of competing ions and look at the ion balance OR iii) quantify organic matter- 

ion interactions…etc. 
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Figure 1. (word style ‘figure and table caption’) Y1 as a function of X1. Add error bars wherever 
applicable. For graphs use IAMT template. 

 after each graph put 3 key observations/findings/outcomes to answer what you wanted to 

know from the graph/figure that you actually see. At the initial stage this is designed to focus 

what you draw from the results (as opposed to finding a reason to explain every up and down 

in the data); 

 do not forget you did these experiments for a reason (see question above graph): could you 

find out what you wanted to know? 

 now that you answered this question; what is the next thing you need to know? If you proceed 

like this then the ‘story’ of your paper will be very obvious and easy to follow for your readers 

(your peers and your supervisor are the first test to see if this works and help you a lot by 

pointing out what is not yet clear). Everyone loves manuscripts that are easy to read and clear! 

Table 1. (word style ‘figure and table caption’) 

 A (unit) B (unit) C* (unit) Reference 

Parameter 1 - - -  

Parameter 2 - - -  

Parameter 3 - - -  

*additional details. 
 3 key outcomes/observations from the table 

 to write an equation follow this: ‘Insert>Equation>InsEq IAMT  

  Type equation here. (1) 

 (Word style ‘equation’). Type the equation in the field. ] 
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7. Appendix 

 additional equations, derivations, calculations etc. required to back up the discussion in the 

main text (move the Appendix section to the supporting information as the CON advances) 

8. Planning (word style ‘Heading-1) 

 [for planning purposes you may add to initial CONs a summary of duration of experiments, 

number of experiments (a table with parameters works well) and if you use expensive or 

restricted materials the amount required. This will help gauge feasibility and time required for 

the work] 

9. References (word style ‘Heading-1) 

[[1] please add in Endnote and ensure that all authors are listed with correct referencing in text  
Check your references diligently as this being sloppy does not give a good impression about your 
work to your supervisor 
Cite only references that you actually have. Citing work based on reading an abstract is unacceptable 
for very obvious reasons. 
Please add a brief paragraph as to what databases you have searced with which keywords (never 
restrict the years in your searches). This can help identify why you are not finding all relevant 
materials. Language is not a deterrent to finding specific data and tools like DEEP-L are a great help 
in translating works that would previously have required language skills (a lot of chemical data is 
publishd in old Russian journals and good scientists find ways and means to find what they need). 
Before you submit your work (electronically and on paper) please proof read it yourself such that 
obvious mistakes such as ‘Error, Reference source not found’ can be corrected. Always incorporate 
comments diligently and discuss when something seems wrong or is unclear. 
For adding references in the main text and supporting information separately in the same document, 
there should be a section break (as the section break following this paragraph, DON’T delete it !). 
Additionally, the endnote style needs to be modified as follows: 
In Endnote, Edit > Output Styles > Edit JMS (eg) > Sections > choose Create a bib for each 
section>save. Now choose this modified endnote style in both Endnote and Word (a sample style is 
in Z(or Y):\IAMT MGMT\Templates\Concept Note and Manuscript outline\additional guidelines.] 
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Supporting Information (Delete this section if not required in the initial versions of the CON) 

1. Supporting info headings (word style ‘Heading-SI’) 
(word style ‘Main text’) Text: as in the main text always write a brief sentence about purpose above 

a figure/table. 

 
Figure S1.  (Insert the caption either by ‘right click on the figure>insert caption>Label: Figure 
S’ OR by selecting ‘Reference>insert caption>Label: Figure S’. After choosing the word style 
‘figure and table caption’, make the ‘Figure S x’ text bold. 

As in the main text always put 3 bullet points about wat you see/learn from this figure/table afterwards. 

For referring a figure in the manuscript by ‘insert>cross-reference>reference type: Figure S, insert 

reference to: only label and number, and select the desired figure’. For eg. ‘Figure S1’ is inserted 

like described which will serve as a link to the figure. Change the bold letter to normal. 

Table S1. (Insert the table caption by either by ‘right click on the table>insert caption, Label: 
Table S’ OR ‘Reference>insert caption>Label: Table S’. After choosing the word style ‘figure 
and table caption’, make the ‘Table S x’ text bold. 

 A (unit) B (unit) C* (unit) 

Parameter 1 - - - 
Parameter 2 - - - 
Parameter 3 - - - 

*additional details. 
To cite a table in the main text, follow this: ‘insert>cross-reference>reference type: Table S, insert 

reference to: only label and number, and select the desired table’. For eg. ‘Table S1’ is inserted by 

following the above method, and then the bold letters are changed to normal. 

References (word style ‘Heading-SI’) 
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Manuscript Template 
Institute for Advanced Membrane Technology (IAMT) 

Prof. Dr. Andrea Iris Schäfer  

Guidelines for using this template  

 Margins are typically fixed at 2 cm each side and page is A4 (not letter), page numbers are included, add line 
numbers as per journal requirement 

 The styles for each sections of the manuscript (title, headings, text, figure, etc.) are present in the template. The 
style names are suffixed with IAMT for easy identification. 

 Each section is marked with corresponding style in parenthesis as ‘(word style ‘xyz’) for identification. 

 The styles can be accessed from the style panel in the ‘Home’ ribbon. Alternatively, the side style panel can be 
accessed by pressing Alt+Ctrl+Shift+S OR by clicking ‘Styles’ dialog button in the lower-right corner of the ribbon 
as shown below (recommended): 

 
Double click on the top portion of floating style panel to fix it on the right side. 
 Each style is formatted with preset font size, line spacing, alignment, indentation etc. Instead of formatting 

manually, click anywhere on the text and select the corresponding style from the panel. For example, to write the 
heading for introduction, type ‘Introduction’ in a new paragraph and select the word style ‘Heading-1’ 

 Between two different styles, there should be a paragraph break (by pressing ‘Enter’) for employing correct 
formatting. BUT, no need to add extra paragraph breaks (‘Enter’) or line breaks (‘Shift+Enter’) anywhere for 
spacing, as the spacing is already included in the formatting.  

 Using sub-headings is described in 2.4 

 Inserting a figure, figure caption and cross-reference is described in 3.1 

 Inserting a table, table caption and cross-reference is described in 3.2 

 Inserting equations and equation cross-references is described in 3.3 

 Supporting information has separate headings and fields. This is described in SI 1 

 Save as .Docx when finished 

 It is recommended to start with this document for writing. To import the styles of this document to an already 
prepared document, open the already prepared document, select File>Options>Add-Ins>Manage: Templates, 
Go. Now a window with templates and add-ins will appear. Attach the template (Manuscript Outline_IAMT 
2020v2.dotm (or a newer version)) and check ‘Automatically update document styles’. Now, the IAMT styles 
will appear in the style panel (However, some fields may not work with this method)  

Note that whenever two documents are mixed, their styles will also be mixed. The present style names are suffixed with 
‘IAMT’ for easy identification. 
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The title (word style ‘Title_main’) should represent the content and emphasis of 

the manuscript clearly and concisely. No abbreviations or long chemicals names. 

Brief titles (~100 characters OR ~15 words) are often impressive 

(word style ‘Author_name’) Author Name1, First-name initial. Surname2, Andrea I. Schäfer1*  

(word style ‘Author_affiliation’) 1Institute for Advanced Membrane Technology (IAMT), Karlsruhe 

Institute of Technology (KIT), Hermann-von-Helmholtz-Platz 1, 76344 Eggenstein-Leopoldshafen, 

Germany 

2Affiliation of the second author (address of the institution where the work was conducted)  

(Affiliation numbers are only required if >1 institution; check spelling of affiliation and names 

carefully; starting with a previous publication as an example is a wise idea) 

(word style ‘corresponding’)*Corresponding author:  Andrea.Iris.Schaefer@kit.edu (A. I. Schäfer), 

+49 (0)721 608  26906  

(word style ‘Journal name’) submitted to 

Journal Name  

Date (DD Mmmm YYYY)  

Abstract (word style ‘Heading-0’) 

(word style ‘Main text-bullet’)  

 Limit the word count to the journal author guidelines (usually 200-500), where 200 is typically 

10-15 sentences. 

 Use short sentences (1-2 lines). Avoid the extensive use of unfamiliar abbreviations in the field. 

If a particular terminology is used repeatedly, use the abbreviation instead after defining it when 

first used. 

 It is good to start with a sentence about the motivation for the work which is usually related to the 

specific problem you are trying to solve. Reflect importance and impact of the work (your overall 

aim). For example, state the particular part addressed of a big problem. Then state the specific 

problem. 

mailto:andrea.Iris.Schaefer@kit.edu
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 Introduce your idea, which should reflect exciting and novel aspects of the work. 

 Describe your approach very briefly highlighting specific, exciting and novel methodology that 

enabled you to carry out your work. 

 Summary of results: answer the three research questions addressed in the manuscript and 

substantiate with main data (qualitatively). 

 Conclude with implications of your answers to the research questions and finish with a good 

impression to the reader that highlights the importance of your work (without exaggerating).  

Further references: i) instructions given by Prof. Andrea I. Schäfer (conference abstracts, only 

partially applicable) and ii) Prof. Bryce S. Richards (Z:\RESEARCH & LEADERSHIP 

TRAINING\Scientific writing skills\Abstract writing guidelines) 

Keywords (word style ‘Heading-0’) 

(word style ‘Main text’) 6 key words max. Keep in mind that right keywords direct your paper to the 

right reviewer and readers. The use of same words in the titles is not recommended, as the words in 

the title automatically appear in indexes and searches. Instead, complement the information given in 

the title. 

Graphical abstract (word style ‘Heading-0’) 

 
Graphical abstract (optional) should give a simple visual impression of the story/highlight of the work as an eye catcher in 
journal contents pages. This is very different to a schematic that you may use in a manuscript. Prepare in high resolution 
(min 300 dpi), typically in ppt, then resize according to the author guidelines and supply as jpg file. Please use graphics 
consistent with other graphics at IAMT (the above figure is from Cai and Schäfer, Journal of Membrane Science, 598 
(2020) 117666)  

1. Introduction (word style ‘Heading-1’) 
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(word style ‘Main text’) for continuous text OR (word style ‘Main text-bullet’) for bullet points. The 

word count of introduction of a typical full-length article would be in the range 1000-1500. For a start 

and to help with structure, add sub-headings. Use bullet point based on topics, not one bullet per 

reference. Bullet point are short, cover the essence and not written as complete sentences (absolute 

max 3 lines). Cover the motivation and background of the work. State the research problem broadly 

and then specifically. Describe the approaches to tackle this problem based on necessary literature 

support. Introduce your approach to this problem. Be original and reflect the importance and 

significance of your approach. State the research questions and objectives towards the end based on 

gaps in literature that you identified in your literature search. Include schematics or tables if necessary. 

References of a full-length article (about 60-80% of the total references) are usually cited within the 

introduction section and then picked up again in the discussion. Do not supplement all the literature 

available on the topic, but extract only those ideas that substantiate the story of paper. Never copy 

any wordings from the literature or other sources. Any sort of plagiarism will result in termination of 

contract without warning with a likelihood of end of career. Any form of ‘Copy-paste-rephrase’ 

writing style is not acceptable practice either. For such matters, please refer to ‘Guidelines for 

Safeguarding Good Research Practice, codes of conduct (DFG-KODEX’, scientific integrity seminar 

slide by Prof. Heinz Kalt (Z:\RESEARCH & LEADERSHIP TRAINING\Research conduct & ethics) 

2. Materials and methods (word style ‘Heading-1’) 

Materials and methods are written in such detail that anyone reading the paper can repeat the work. 

Naturally this also requires that the results that are published are actually reproducible. Please look at 

previous publications from IAMT for the most suitable structure. It is best to start with the most 

important part of your work, usually the filtration system and/or the membrane. 

2.1. Membrane filtration system (word style ‘Heading-2) 

(word style ‘Main text’) Describe all the the filtration system used with all details. Refer to prior 

publications if you are not the first user. For equipment give Type (model, supplier, location).  

2.2. Protocols, system setup (word style ‘Heading-2) 

(word style ‘Main text’) Describe the protocols, filtration system or experimental setup such that a 

third person can reproduce the experiments. Add manufacturers and instrument types. 

2.3. Chemicals, membranes and pollutants (word style ‘Heading-2) 

(word style ‘Main text’) Describe all the chemicals, membranes and pollutants used for the study with 

supplier, purity, etc. 
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2.4. Analytical methods, data analysis and calculations (word style ‘Heading-2) 

(word style ‘Main text’) Describe the analytical tools, data acquirement and interpretation 

methodologies, calculation and modeling etc. that you adopted. Put the calibration curves and limit 

of detections (follow previous papers) in the SI. 

2.5. Error analysis 

(word style ‘Main text’) Describe the error propagation publication as applied to your work [1]. This 

requires a thoughtful analysis of procedures and a common-sense assessment of factors contributing 

to error, rather than just equations. You need to have a really good feeling what the main errors in 

your work are and how reproducible your data is (pick one experiment that is difficult, but typical, 

and repeat 5 times. Note that some journals now reject publications without meaningful error analysis. 

2.6. Use subheadings further (word style ‘Heading-2) to ease the reading 

(word style ‘Main text’) To write a new ‘level 2’ heading, e.g. 2.6 after this paragraph, follow these 

steps: (1) hit ‘enter’ at the end of this paragraph to start a new line. (2) click ‘Numbering’ icon next 

to ‘Bullets’ icon on the top ribbon. Now, a ‘level 1’ numbering (e.g. 1.) will appear. (3) select 

‘Heading-2’ from the style panel to get 2.6 OR ‘Heading-3’to get 2.5.1. To switch a heading level 

between levels 1-3, just click anywhere on the heading and select the required level (Heading-

1/Heading-2/Heading-3) from styles panel. 

2.6.1. Using level 3 headings (word style ‘Heading-3’)  

(word style ‘Main text’) Use of level 3 headings like 2.4.1 (‘word style ‘Heading-3’) are usually not 

necessary and not recommended. If level 3 is used (it is recommended to avoid it), try to maintain the 

same pattern throughout the document, such that level three headings are used in all sections, rather 

than just in one section which indicates an unbalanced structure. Check the structure of your 

document by displaying the navigation pane. Looking at the headings should give an idea of the story 

of your paper, while a similar number of headings in literature, methods and results sections is usually 

a good sign of balance. 

3. Results and discussion (word style ‘Heading-1’) 

(word style ‘Main text’) Use the word style ‘Main text’ for paragraphs. 

3.1. Figures  

ALWAYS write a brief sentence about purpose above a figure/table (what is is you need to know by 

doing the next set of experiments?). Then show the figure and after the figure/table add 3 bullet points 
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about what are the main observations from the figure. The magic number of three forces you to focus 

on the main observations – remember: you wanted to know something before you did this, did you 

find out? This is done in the manuscript and in the SI.  

In advanced stages of the CON (also referred to as an outline [2]), a discussion is added to these 

points (with literature references) but this is only done once the focus is clear and it is agreed what 

the main points are (the aim is to develop both focus and the story line). Once the main points are 

clearly discussed in the first few versions of a manuscript (Outline in bullet points), then the 

manuscript can be developed in to full text. At this stage, the three bullet points must be developed 

in to paragraphs by incorporating detailed discussions and supportive literature. It is important here 

to not loose the structure of the 3 points. 

For preparing the graphs with Origin, use the IAMT template(s). To insert a figure from Origin, export 

the graph to an image file (File>Export graphs). Use the following settings (check and comply with 

the guidelines of the journal before final submission):  

image type  : JPEG 
margin control  : tight in page 
Specify size in  : cm 
Rescaling   : width 
Fit width  : 9 (for single plot), 14 (for double plot) and 19 (for triple plot graphs) 
DPI resolution  : 600 
Insert graph image to manuscript (Insert>Pictures>select and insert the desired picture) 
Do not resize the graph by dragging the corners within the manuscript.  
After inserting the figure, click on the figure and use word style ‘Figure’. 

 
Figure 1. (word style ‘figure and table caption’) Y1 as a function of X1. Add error bars wherever 
applicable. The caption should be clear and understandable without referring to the main text. Do 
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not use complete sentences and keep captions short and concise. Insert the caption either by ‘right 
click on the figure>insert caption>Label: figure’ OR by selecting ‘Reference>insert 
caption>Label: figure’. After choosing the word style ‘figure and table caption’, make the ‘Figure 
x’ text bold. 

For referring a figure in the manuscript by ‘insert>cross-reference>reference type: figure, insert 

reference to: only label and number, and select the desired figure’. E.g. ‘Figure 1’ is inserted like 

described which will serve as a link to the figure. Change the bold letter to normal. 

If multiple images need to be arranged as a single figure, firstly use a table to hold the figures in place 

(table with no visible margins and no margins in the cells). To merge figures or create schematics 

please use programs accessible to all team members, like Visio or power point to arrange the figures 

and save them with required width and resolution. Always keep the source file and add this to your 

manuscript file so modification is possible later. 

A table may be also used as a quick way to organize multiple images (e.g. SEM images) in to single 

figure as demonstrated below. Insert a table with required number of rows and columns (2x2 in this 

example). In the table properties>options>uncheck ‘automatically resize to fit contents’. Now 

click inside each cell and insert the images. Use text box without outlines to label and for labels in 

figures use a plain font (such as Arial or Calibri) rather than Times. 

  

  

This table is now needed to be converted to a figure, as a figure caption cannot be added to this as a 

field. To covert this in to a figure, copy the whole table, go to a new line (press ‘Enter’) and select 

A B 

C D 
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Insert>Object >Object type: Microsoft word-Document. This will open a new blank document. 

Paste the table in the new blank document and close it. The table is now added as a figure in the new 

line (see below). Crop off the edges if present in excess. Captions can be added to this new figure and 

it must be referenced in the text as described in the previous section. (Delete the original table now). 

HOWEVER, it is NOT possible to control the image properties with this method.  

  

  
 

A B 

C D 

 

3.2. Tables 

Table 1. (word style ‘figure and table caption’) Insert the table caption by either by ‘right click on 
the table>insert caption, Label: table’ OR ‘Reference>insert caption>Label: table’. After 
choosing the word style ‘figure and table caption’, make the ‘Table x’ text bold. 

 A (unit) B (unit) C* (unit) 

Parameter 1 - - - 

Parameter 2 - - - 

Parameter 3 - - - 

*additional details. 
To cite a table in the main text, follow this: ‘insert>cross-reference>reference type: table, insert 

reference to: only label and number, and select the desired table’. E.g. ‘Table 1’ is inserted by 

following the above method, and then the bold letters are changed to normal. 
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3.3. Equations 

To write an equation follow this: ‘Insert>Equation>InsEq IAMT  

  Type equation here. (1) 

Select the table and apply the word style ‘equation’. Type the equation in the field. (Note that the 

equation field is a single raw table with no borders).  

To cite the equation in the main text, type ‘equation’ and follow this: ‘insert>cross-

reference>reference type: equation, insert reference to: only label and number, select and insert 

the desired equation and then close the parenthesis’. E.g. ‘Equation Error! Reference source not 

found.’ is typed following the above method, for which the equation number is linked to the equation 

field. 

After inserting fields such as figures, tables and equations, right click on each field and select ‘update 

field’ to make sure that the automatic sequential numbering is updated. Alternatively, to update all 

the fields in the document at once, select all text (Ctrl + A) and then press ‘F9’.  

4. Conclusions 

(word style ‘Main text) Conclusion should not be the repetition of abstract. Reflect the story and the 

major findings of the work in the conclusions with more detail than the abstract. No copy and paste 

(it should go without saying!) between abstract and conclusions. 

5. Acknowledgements 

(word style ‘Main text) Acknowledge the funding agencies, scholarships, technical assistance and 

troubleshooting, material donations, fruitful discussions that contributed to the manuscript, proof 

reading etc.. DO NOT forget anyone who contributed to your work and to ensure that no one is 

forgotten start with this section early in your concept note rather than doing this last. 

6. Supporting information 

Reference this resource here and state briefly what it contains (SI is not published with the manuscript 

and it is not reviewed, it is simply made accessible via weblink later) 

7. References 

[1] (word style ‘Reference’). Use Journal of Membrane Science endnote style 
(https://endnote.com/style_download/journal-of-membrane-science/) as the default referece style 
(unless a particular journal style is required – which is usual for every journal). 

https://endnote.com/style_download/journal-of-membrane-science/
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[2] Follow the reference formating guidelines of the journal. The reference style provided in Endnote 
program or website need not be updated with a journal style and always check manually that the 
recommended style is followed. Correct problems in your Endnote database. 
[3] The number of references varies, for a typical manuscripts is may be somewhere between 40 and 
60. Keep in mind that the references influence the selection of reviewers. Try to include updated 
literature. Minimize self citation and always cite the source reference, not secondary references. 
Finding good references often indicates the quality of the research and the best researchers find 
obscure data in old Russian journals and manage to translate this (yes, curiosity has no limits). 
[4] Do not cite references that you do not have either based on abstracts (for papers that may be 
difficult to access) or based on other authors citing the work. There is no excuse for such lazy 
shortcuts and it reflects very badly on you as a researcher. Creativity to get the most obscure paper 
(even when the library cannot help) will take you a long way. 
[5] For adding references in the main text and supporting information separately in the same 
document, there should be a section break (as the section break following this paragraph, DON’T 
delete it !). Additionally, the endnote style needs to be modified as follows: 
In Endnote, Edit > Output Styles > Edit JMS (eg) > Sections > choose Create a bib for each 
section>save. Now choose this modified endnote style in both Endnote and Word (a sample style is 
in Z(or Y):\IAMT MGMT\Templates\Concept Note and Manuscript outline\additional guidelines.  
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Supporting information (exactly same first page as first page of manuscript) 

Title 

(word style ‘Author_name’) Author Name1, First-name initial. Surname2, Andrea I. Schäfer1*  

(word style ‘Author_affiliation’) 1Institute for Advanced Membrane Technology (IAMT), Karlsruhe 

Institute of Technology (KIT), Hermann-von-Helmholtz-Platz 1, 76344 Eggenstein-Leopoldshafen, 

Germany 

2Affiliation of the second author (address of the institution where the work was conducted)  

(word style ‘corresponding’)*Corresponding author:  Andrea.Iris.Schaefer@kit.edu (A. I. Schäfer), 

Tel.: +49 (0)721 608 26906  

The supporting information needs to have a logical structure (grouping things together that belong 

together in the right order), while all the figures and tables need to be referred to in the main 

manuscript. 

1. Supporting info headings (word style ‘Heading-SI’) 
(word style ‘Main text’) Text: as in the main text always write a brief sentence about purpose (What 

do you need to know when doing this?) above a figure/table. 

 
Figure S1.  (Insert the caption either by ‘right click on the figure>insert caption>Label: Figure 
S’ OR by selecting ‘Reference>insert caption>Label: Figure S’. After choosing the word style 
‘figure and table caption’, make the ‘Figure S x’ text bold. 

mailto:andrea.Iris.Schaefer@kit.edu
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As in the main text always put 3 bullet points about wat you see/learn from this figure/table afterwards. 

For referring a figure in the manuscript by ‘insert>cross-reference>reference type: Figure S, insert 

reference to: only label and number, and select the desired figure’. For eg. ‘Figure S1’ is inserted 

like described which will serve as a link to the figure. Change the bold letter to normal. 

Table S1. (Insert the table caption by either by ‘right click on the table>insert caption, Label: 
Table S’ OR ‘Reference>insert caption>Label: Table S’. After choosing the word style ‘figure 
and table caption’, make the ‘Table S x’ text bold. 

 A (unit) B (unit) C* (unit) 

Parameter 1 - - - 

Parameter 2 - - - 

Parameter 3 - - - 

*additional details. 
To cite a table in the main text, follow this: ‘insert>cross-reference>reference type: Table S, insert 

reference to: only label and number, and select the desired table’. For eg. ‘Table S1’ is inserted by 

following the above method, and then the bold letters are changed to normal. 

To add an equation, follow: ‘Insert>Equations>InsEq_SI IAMT’ 

 Type equation here. (S1) 

Select the table containing equation and apply the word style ‘equation’. Type the equation in the 

field.  

For citing the equations of supporting information in the text, each equation has to be bookmarked. 

To do this, select the text inside the parenthesis of equation e.g. S1, then Insert>Bookmark>type the 

bookmark name for eg ‘Equation_S1’, then Add.  

Now to cite the equation S1 in the text, type ‘Equation’ and follow this: ‘insert>cross-

reference>reference type: Bookmark, insert reference to: Bookmark text, select and insert the 

desired equation and then close the parenthesis’. E.g. ‘Equation S1’ is typed following the above 

method, in which the equation number is linked to the equation field.  

2. References (if any, word style ‘Heading-SI’) 
 
1. Imbrogno, A., M.N. Nguyen, and A.I. Schäfer, Tutorial review of error evaluation in 

experimental water research at the example of membrane filtration. Chemosphere, 2024. 357: 
p. 141833. 

2. Whitesides, G.M., Whitesides' group: writing a paper. Advanced Materials, 2004. 16(15): p. 
1375-1377. 
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 The purpose of peer review at IAMT is to pick up errors in manuscripts that do not require the expertise 
of a professor and hence speed up the revision time and hopefully the number of required revision 
rounds 

 It is helpful to take this feedback form and check in a self-check before requesting feedback from others; 
before giving a CON to anyone for feedback, print it and read carefully to check for errors (some broken 
links only show when printing). If there are too many obvious errors, please refuse to peer review, bounce 
the work back to the author to revise and return to you when ready. If the authors do not have the time 
to do this then the peers should not spend time looking at such work. Authors giving their very best. 

 If there are several authors from IAMT in role of student and postdoc then this peer review should be 
incorporated in this author team (without confusing peer review with supervision); the quality of the 
work should be that of the most experienced author. 

 Good peer review will practice the ability to critique the work of others, concentrate while reading and 
express feedback with the intention to help the author to improve their work. The intention is not to 
grade and judge (no matter if this is ‘this is fine/good’ or ‘this is rubbish’), the intention is to help improve. 
While you peer review, you learn – how to do things better and about the work of other team members! 

 We can always improve and this means in research making work more readable, getting published in 
higher impact journals and getting more citations because readers find our work really helpful, 
interesting, and well written.  

 Attach this form when work is given to me so I can evaluate the quality of peer reviewers (and note how 
long it took you, this is interesting for your learning and time management (you will get faster the more 
you review but don’t put more than 1-2 hours!)). 

 Please respect each other’s time, every successful researcher is by nature very busy. Be mindful how 
many reviews you carry out – being asked too often may be nice for the ego but it is damaging for your 
career. The appropriate answer when receiving feedback is ‘thank you for your time’. 

 
CHECKLIST FEEDBACK COMMENTS/SUGGESTIONS 
Has the manuscript template been 
followed diligently 

 
 

 

If you check the structure in the 
navigation pane, are the number of 
headings balanced across 
literature/materials/results sections and 
is a story obvious from headings? 

  

Are all references complete and correctly 
formatted (capitals, abbreviations, 
completeness, etc.) 

  

Are the references up to date (few 
references from the last 2 years indicate 
that nothing was updated during long 
revision; this is ongoing and even after 
submission literature is to be updated) 

  

Is there a large number of IAMT (Self) 
citations that are not immediately 
relevant? 

  

Has everyone named as an author 
contributed to the CON and revised (if 
not the add as unconfirmed author) 
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Has the research aim been written for a 
general audience (dinner party, 
grandparents, etc...)? 

 
 

 

Is the problem clearly defined (this is the 
most important aspect of a CON) 

 
 

 

Verify if all statements can be 
substantiated with data and findings are 
not ‘exaggerated’. Humble is better than 
arrogant. 

  

Are the research questions clear and in 
agreement with the problem (they ought 
to help solve the problem!) 

 
 

 

Does the work fit the proposed journal 
and is the quality/novelty matching the 
quality and/or impact factor (IF) 

  

Are all suggested reviewer experts in the 
specific filed and are people we know 
and respect (we don’t suggest reviewers 
we do not know, the editor will find 
these!) 

  

Is the novelty clear (what is it)?   
Is the abstract written as required 
(problem, significance, key method, 
answer to research questions (with 
quantitative data) and implications of the 
work) 

 
 

 

Are figures all the same size, units 
consistent/correct and graphs follow the 
template? 

  

Are the schematics unique (nothing can 
be published twice), clear and of IAMT 
quality (we have templates and libraries 
for all to use and expand: take & 
contribute!) 

  

Are captions concise (no full sentences) 
and are conditions clearly stated? 

  

Are equations all text size and are all 
symbols defined with units?  

  

Is each literature section clear with 3 
main points to be communicated? 

 
 

 

Are bullet points concise with max 3 lines 
and no full text language? 

  

Is a statement what you need to know 
added above each graph/table in CON 
and SI. Note in SI there is no need to 
write full text later, this can remain in 
bullet style 

  

Are there no more than 3 bullet points of 
what was observed in a graph/table (that 
hopefully answers what you needed to 
know?* 
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Is the story clear and comprehensible (all 
IAMT papers must be comprehensible to 
IAMT team members!) 

  

Are error bars added to all data and is the 
calculation clear with a common-sense 
approach on where the main error 
originates from? 

  

If there is flaws in the data – say it. There 
is nothing worse than covering up 
problems, what can be fixed will be fixed, 
what cannot can be indicated as a flaw. 

  

Are all figures and tables cross-
referenced in the text (incl those in the 
SI) 

  

Does the SI include calibration, detection 
limit and validation (sample matrix) of 
analytical instruments) 

  

Is all raw data included in the SI?   
Is the SI well-structured /ordered and 
formatted with first page as manuscript 

  

OTHER SUGGESTIONS?   
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[the purpose of this document is to check that all requirements for submission have been fulfilled to reduce 
unnecessary queries for completion and accidental omissions. Please read journal author guidelines and attempt 
a mock submission to see what is required for a particular journal. Strictly follow journal guidelines and ensure 
all required forms are included. Attach this file in the final manuscript ready to submit and ensure that all tasks 
have been completed]. 
[‘’ whichever applicable and attach documents] 

☐ Manuscript 
☐ Supporting information [attached at the end of the manuscript or as separate document, depending on journal preferences] 
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